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 Имеется возможность использования в плохих метеоусловиях, которые не считаются 

оптимальными для выполнения объемной фотограмметрии (ветер, дождь, низкая 

облачность)[3]. 

Цифровые модели местности и создание планов и карт на основе ортофотопланов 

становятся всѐ более востребованными инструментами для горнодобывающих компаний в 

плане организации и управлении работ, экологического контроля, расчѐта объѐмов и 

планирования. При разработке месторождений полезных ископаемых особенно открытым 

способом необходима постоянная съѐмка местности.  Горнодобывающие компании несут 

значительные финансовые и временные затраты на проведение наземных геодезических 

работ.  

Применение БЛА актуально при реализации инфраструктурных проектов. Проектные и 

строительные компании  остро нуждаются в оперативной съѐмке и подробных ортопланах. 

Получение общей картины на объектах инфраструктуры в динамике, крайне важно для 

контроля строительства и предотвращения возможных отклонений от проекта. 
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Мы живем в XXI веке, когда весь мир открыт для любого из нас. Сейчас во всех 

странах широко приветствуется и поддерживается туризм. Но очень сложно представить 

путешествие без карты, тем более, если вы собрались не просто посетить разные страны, а 

познакомится с местными достопримечательностями, памятниками и местами отдыха, в этом 

случае вам не обойтись без туристических карт. 

Так что же такое туристические карты и для чего они служат? Карты туристские 

предназначенные для туристов, путешественников и просто для отдыхающих. В их 

содержании основное внимание уделено достопримечательным местам. Они могут изоб-

ражать обширные курортные районы, национальные парки, города, отдельные лыжные, 

пешеходные, водные маршруты и т.п.  Карты данного типа  отличаются красочным 

оформлением, сопровождаются подробными указателями и справочными сведениями [1].  

Данная разновидность карт очень востребована и популярна среди туристов, поэтому 

их создание и распространение является весьма актуальной задачей. К ее решению можно 

подходить различными способами, можно создавать аналоговые карты, а можно цифровые, 

есть возможность как обновления карт на основе уже существующих, так и создание 

принципиально новых туристических карт. 

В данной статье будет рассмотрено создание новой туристической карты на основе 

уже существующей аналоговой физической карты Казахстана. Следует сразу отметить, что 

http://www.racurs.ru/?page=681
http://www.multicopter.ru/microcopter
mailto:denkucherenko@mail.ru
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вся работа будет производиться в пакете программ ArcGIS 10.1, принадлежащей 

американской компании ESRI. Программа, используемая при создании данной базы данных, 

а впоследствии и карты, не подвергалась русификации. Вследствие этого, все команды и 

процессы будут описаны на английском языке.  

 
рис. 1 

 

Как было сказано выше, в качестве основы, с которой будет взята первоначальная 

информация, будет служить растровое изображение отсканированной карты. Перед 

созданием новой карты необходимо привязать базовую карту к рабочей системе координат, в 

качестве которой была использована система координат «Пулково 1942». Данная операция 

производится при помощи панели «Georeferencing». По итогам проведенных операций 

получена карта, приведенная на рис. 1.  

Следующим шагом будет векторизация всех горизонталей и значимых точек рельефа 

на отдельных слоях. Для этого в ArcCatalog создаем новые шейп-файлы. Для слоя, на 

котором будут находиться горизонтали, определяем тип объектов Polyline (полилиния), так 

как горизонтали представлены на карте как замкнутые линии; а для шейп-файла с 

характерными точками рельефа – Point (точка). Назовем их «Horizontals» и «Main points of 

land» соответственно. У каждого слоя в таблице атрибутов создаем новый столбец с 

наименованием «Height», в котором указываем высотные значения. После добавления шейп-

файлов в ArcMap при помощи команды «Add» и их последующей векторизации мы получаем 

оцифрованную модель рельефа, представленную линиями равных высот и наиболее 

высокими и низкими точками рельефа (рис. 2).  

 
рис. 2 

Неоспоримо, что данное 

представление рельефа является наиболее 

популярным в научной среде, т.к. оно 

обладает высокой метричностью,  что 

рис. 3 
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позволяет с большой точностью определять абсолютную и относительную высоты точек, 

форму и крутизну склонов. Но для этого необходимо обладать определенными навыками 

чтения карт, которыми большинство пользователей туристическими картами не обладают. 

Учитывая этот фактор, наиболее разумным будет перейти к изображению рельефа шкалами 

гипсометрической окраски. Которое обладает большей красочностью и выразительностью, 

что позволит облегчить читаемость. Данный процесс рассмотрим как можно более подробно 

[2].  

Создание наглядной модели рельефа начнем с постоения триангуляционной сети TIN 

(Triangular Irregular Networks). TIN является формой векторных цифровых географических 

данных, которые строятся методом триангуляции набора вершин. Вершины соединяются 

серией ребер и формируют сеть треугольников. Создание модели TIN производится при 

помощи панели инструментов ArcToolbox: ArcToolbox > 3D Analyst Tools > Data Management 

> TIN > Create TIN. После чего откроется окно создания TIN (рис. 3), в котором 

последовательно заполняем все графы: 

 Output TIN – задается местоположение и название (elevation) модели; 

 Coordinate System – используемая координатная система (Пулково 1942); 

 Input Feature – слои, используемые при создании триангуляции; 

 Height Field – столбец в таблице атрибутов, содержащий высотные значения объектов; 

 SF Type – тип объектов (точка, полилиния или полигон). 

После нажатия кнопки «ОК» ArcMap автоматически создает модель TIN, которая 

представлена на рис. 4 [3]. 

 Но так как использование TIN, из-за сложности их структуры, несколько менее 

эффективно, чем обработка растровых данных, то разумнее будет конвертировать 

триангуляционную сеть в растровое изображение. Для этого вновь воспользуемся набором 

инструментов ArcToolbox: ArcToolbox > 3D Analyst Tools > Conversion > From TIN > TIN to 

Raster. В открывшемся окне  указываем модель TIN, на основе которой будет производиться 

преобразование, а также расположение и название (dem) получаемого растра.  

 
рис. 4 

Но так как по умолчанию растр создается в черно-белой цветовой гамме, нам 

придется преобразовать его отображение. 

Для этого откроем окно свойств только 

что созданного растра: dem > Properties > 

Symbology > Classified. В открывшемся 

окне (рис. 5) изменяем цветовую гамму и 

градацию цветовой шкалы. В 

выпадающем списке «Classes» выбираем 

необходимое количество цветов, 

характеризующих различные высоты. 

Затем, нажав на кнопку «Classify…», 

рис. 5 



4577 
 

необходимо вручную ввести высоты, при пересечении которых цвет будет меняться на 

соседствующий ему в гипсометрической шкале. Цветовую гамму принимаем аналогично 

цветам исходной карты. По окончании выполнения всех операций перечисленных выше 

получится цифровая модель рельефа в формате растрового изображения, представленная на 

рис. 6. Изображение, которого мы добились, полностью соответствует тем требованиям, 

которые были поставлены в начале этой статьи. А именно красочности, наглядности и 

легкой читаемости даже неподготовленным пользователем [3]. 

 
рис. 6 

После получения рельефной составляющей будущей туристической карты продолжим 

создание полноценной физико-географической основы. Для этого необходимо векторизовать 

гидрографию и некоторые политико-антропогенные элементы.  

Для добавления гидрологических элементов создаем в ArcCatalog два новых шейп-

файла: 

 «Lakes» – для озер с типом объектов Polygon (полигон); 

 «Rivers» – для рек с типом объектов Polyline (полилиния). 
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рис.7 

В таблице атрибутов каждого из выше указанных слоев в добавленном столбце 

«Name» указываем название водоема. Для озер укажем еще один дополнительный атрибут – 

в столбце «Type» уточняем тип озера (соленое или пресное). После окончания векторизации 

и заполнения таблицы атрибутов приступаем к оформлению гидрографии. Для 

корректировки изображения рек откроем вкладки Rivers > Properties > Symbology > Features, 

где определим отображение линии, воспользовавшись уже существующим стилем ESRI с 

одноименным названием «River». Теперь реки изображены в форме тонких голубых линий. 

Для редактирования изображения озер перейдем по ссылкам Lakes > Properties > Symbology 

> Categories, где для пресных озер определяем стандартный стиль ESRI «Lake», для соленых 

озер изменим изначальную голубую цветовую гамму того же стиля на розовую. Далее 

подписываем на карте все объекты, воспользовавшись командой «Label Features». 

Активировать и переопределить стиль надписей можно, перейдя по ссылке Properties > Label, 

для каждого слоя отдельно. Окончательный вид гидрографии представлен на рис. 7 [3]. 

Из политических составляющих добавим на карту все наиболее крупные города, а 

также государственные и областные границы. Категории городов определим по 

административно-территориальному делению. Также при помощи команды «Label Features» 

подпишем название всех городов. Результат последних действий представлен на рис. 7. 

После создания полноценной географической основы нашей карты. Можно 

приступить к нанесению архитектурных, исторических памятников, мест отдыха, курортов, 

заповедников и других живых монументов природы. Распределив их по категориям, 

присвоим каждому отдельную иконку. После чего для получения полноценной карты 

перейдем в вид компоновки (View > Layout View), где необходимо добавить координатную 

сетку, легенду и другое зарамочное оформление географической карты. Для повышения 

красочности добавим несколько изображений достопримечательностей в оставшиеся 

свободные места. По окончании этих действий получена готовая аналоговая туристическая 

карта, которая представлена на рис. 7. 

Но после создания аналоговой карты вернемся к цифровой карте. Следует отметить, 

что данные карты получили широкое распространение в интернете. Но потенциальный 

турист не захочет ехать в другую страну, зная лишь название города и курорта. Определенно 

он захочет узнать дополнительную информацию, посмотреть фотографии и сделать все это 

не покидая данной карты. Эта задача может быть решена благодаря  инструменту ArcMap 

под названием «HTML Popup». Эта расширенная опция позволяет добавлять рисунки, 

документы и другие вложения. Но если для отображения текста не требуется никаких 

действий, кроме заполнения соответствующей ячейки в таблице атрибутов, то представление 

рисунков требует более трудоемких процессов. Необходимо, используя язык 

программирования HTML, написать ссылку на изображение в отдельном столбце 

атрибутивной таблицы. Выглядит она следующим образом: <img src="C:\training 

base\Attractions\Pictures\Sights of nature\almaty lake.jpg" width='300' />. Где обязательно надо 

указать расширение файла и его размер 

при отображении всплывающего окна. 

Результат представлен на рис. 8 [3].  

Теперь каждый пользователь 

может легко просмотреть краткую 

иллюстрированную информацию о 

любом городе, курорте или памятнике 

истории, представленном на карте. 

Использование таких опций является 

преимуществом цифровых карт перед 

аналоговыми, так как при одинаковой 

визуальной нагруженности карт 

количество содержащейся информации в 

рис. 8 
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электронной карте в несколько раз больше. Достигается это благодаря тому, что вся 

атрибутивная информация скрыта и появляется лишь в нужный момент и для необходимого 

объекта. 

В данной статье были рассмотрено создание карты общего пользования при 

соблюдении всех картографических составляющих, в том числе координатной системы, 

картографической семиотики и топонимики. Следует отметить, что данное направление 

разработки карт пока не получило широко распространения, не смотря на то, что подобные 

картографические произведения представляют настоящую кладезь знаний для 

путешественников. И, принимая во внимание то, что все большее количество туристов едут в 

нашу страну, данная проблема становится все более актуальной. Надеюсь, что данной 

статьей я смог приблизить ее решение, создавая достойное картографическое сопровождение 

для людей, желающих лицезреть красоту нашей Родины. 
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С 2009 года Европейским космическим агентством ESA  ведется разработка 

программного комплекса NEST (Next ESA SAR Toolbox), которая на данный момент имеет 

открытый доступ на официальном сайте компании в глобальной сети Интернет. 

Космическим агентством ESA в рамках проекта ERS Tandem  проводился 

космический мониторинг действующего вулкана Этна,  расположенный на восточном 

побережье Сицилии. Площадь вулкана составляет 1,25 тыс. км
2
.   

Данные исследования проводятся для изучения сантиметровых подвижек земной 

поверхности с применением интерферометрических методов.  

Пример обработки снимков состоит в следующем: 

1. Создании проекта, начиная с подмножеств данных; 

2. Применение «Delft- Точные орбиты»; 

3. Корегистрации подмножеств; 

4. Генерация интерферограмм; 

5. Сравнение интерферограмм и их согласованность между собой; 
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